Google Apps: An Introduction to Docs, Scholar, and Maps

This document provides an introduction to using three Google Applications: Google Docs, Google Scholar, and Google Maps. Each application is free to use, some just simply require the creation of a Google Account, also at no charge.

Creating a Google Account

To create a Google Account,

2. At the top of the screen, select “Gmail”.
3. On the Gmail homepage, click on the right of the screen on the button that is labeled “Create an account”.
4. In order to create an account, you will be asked to fill out information, including choosing a Login name which will serve as your email@gmail.com, as well as a password. After completing all the information, click “I accept. Create my account.” at the bottom of the page.
5. After you successfully fill out all required information, your account will be created. Click on the “Show me my account” button which will direct you to your Gmail homepage.

Google Docs

Now that you have an account created with Google, you are able to begin working with Google Docs. Google Docs is an application that allows the creation and sharing of documents, spreadsheets, presentations, forms, and drawings online. Users can collaborate with others to make changes to the same document.

1. Type in the address www.docs.google.com, or go to Google’s homepage, http://www.google.com, click the more drop down tab at the top, and then click Documents.
2. Sign in with your Google Account information, then click **Sign in**.
3. You will now be directed to your home page where all your documents will be listed.

Creating and Uploading Documents

In Google Docs, you have the option of creating new documents, spreadsheets, or presentations from scratch or you may upload documents from your personal computer.

To create a new document in Google docs,

1. Click the **Create new** tab on the left of the page. In the drop down menu, select the type of document you wish to create.

2. After selecting your document type, you will be directed to a page that looks and functions similarly to Microsoft Office programs.
   a. If you select **Document**, you will be guided to a screen that looks similar to Microsoft Word. Here, you can enter your text and insert objects and add formatting as you would in Word.
b. If you select Presentation, you will be guided to a screen that resembles a simplified version of PowerPoint.
   
i. **Right click** with the mouse for an easily accessible drop down menu.

ii. To import slides from another PowerPoint saved on your computer, select **Insert** then **Import slides**. Click **Browse** to look through your files and click **Upload** to insert the slides you wish to add to your presentation.
c. Selecting **Spreadsheet** will give you a template similar to Excel. You are able to do most tasks as in Excel.

![Spreadsheet insert](image)

- **Insert functions**
- **Insert rows, columns, charts, or images**
- **Use the Tools tab to sort your data, freeze rows, or check spelling**

d. The **Form** template is a very valuable tool when surveying a large number of people through email. It is simple to use and can be customized to your exact needs.

![Form template](image)

- **Add questions and choose the type of answer (multiple choice, scale, etc.)**
- **Choose from a variety of themes**
- **Enter text for your Question as well as your Answers**
i. After adding all your questions, you are able to click a link at the bottom of your editing screen to view how your questionnaire will look when opened by your viewers.

ii. On the top of the editing page, select **Email this form** to send to others.

![Add emails of recipients](image)

iii. After others receive your email and submit their answers, you will receive an email with a link to a spreadsheet tracking all responses. The spreadsheet organizes your data for you.

![Spreadsheet tracking responses](image)

e. The **Drawing** template is similar to Paint. The **toolbar** along the top allows you to change colors, undo actions, or add text.

![Drawing toolbar and options](image)

3. **Uploading documents to Google Docs**
   a. To upload a document from your computer, select **Upload** in the upper left corner.
b. In the next screen, you will be able to select your files. Click **Select files to upload**, browse through your files and click **open**. Choose the folder you want your file to go to with the **Destination folder** dropdown tab. Then choose your file settings with the **Private** dropdown tab. Select **Start upload**.

4. Creating a new **Folder** is an easy way to organize your documents in one single place by who you share them with, different topics, or however you choose.

a. To add items into your folder, select **All items** at the left of the screen, **Check the box** of the document(s) you wish to move, select the **Folders tab**, then **check the box** of the folder you wish to add the documents to. Select **Apply changes**.
In all of these applications, the **File tab** on the toolbar across the top allows you to save your documents to your Google account.

**Sharing Your Documents**

One main advantage of Google Docs is the ability to share documents with others so it is easy to collaborate and edit as a group.

1. To share a document,
   a. Select the document you wish to share and click the **lock button** next to the title of the document.
   b. A box will appear that will allow you to add people to invite to edit or to view your document. Selecting the **Can edit** dropdown box will allow you to change their editing or viewing settings. Select **Share** when you are ready to send your document.

Enter email addresses of those you wish to share with, or choose from your contacts.
c. When other users receive the email, they are able to open a link to the document and edit if they are allowed. If they save the changes they make, others will see those changes in their own copies of the same document.

2. To share a folder containing documents,
   a. **Right click** on the folder located on the toolbar to the left of the page. Select **Share**, and then **Sharing settings**.

   ![Folder Sharing Settings](image)

   b. Like instructed previously, enter the email addresses of the users with whom you would like to share the folder, or choose from your list of contacts. Select their settings with the **Can edit** box. After making your changes, select **Share**, and they will have access to all documents contained in the folder.

3. To view past changes made and see the revision history,
   a. In the document you are editing, select **File**, and **See revision history**.

   ![Revision History](image)

   b. View past revisions by selecting the dropdown menu with the time and current user, or selecting **Newer** and **Older** in the toolbar. To return to editing the page, select **Back to editing**.

4. To simultaneously edit a document with your shared members,
   a. Click the **blue dropdown bar** at the top right of the document. You will be able to see who is viewing the document with you, and then you will be able to enter
text in the **chat box** and chat live while viewing and editing your document together.

Quick Tips for Google Docs

1. Enter full-screen mode to avoid distractions of other menus.
   a. By pressing **F11**, onscreen menus and links will be eliminated from your view of your document. This option is not currently available for Mac users.

2. The **Insert** tab offers many useful tasks in the document template. Insert equations, images, links, and other tools with a click.

![Insert tab]

- Easily insert headers and footers into your document, or customize a table of contents
- Insert comments for other users to see while viewing/editing your shared document
- Enter text in the chat box to talk with collaborators
Google Scholar

Google Scholar is a search engine that assists in the search of articles from many different scholarly databases. It is a valuable tool to utilize; however, keep in mind that many articles are embedded in databases and journals, and Google cannot search for those. Although many articles may be retrieved from a search, there are many more that may be accessed using databases through UIS’ Brookens Library at http://library.uis.edu.

To access Google Scholar,

1. Go to www.google.com, select the more dropdown tab, and click Scholar. You can also access it by typing www.scholar.google.com.

2. You will be directed to a page that similarly resembles the Google homepage. Notice the word “beta” included in the Google logo. This means Google Scholar is in its “test” version and is still undergoing development. You may encounter inconsistencies while working with it.

Searching for Articles

There are a variety of options to search for articles. A simple way is to type keywords into the search bar.

1. When typing keywords for the topic you are researching, make sure you put quotation marks around words that make up the phrase for you are looking.

   a. Searching by author is one of the most accurate ways to find a specific paper. Place their name in quotation marks, after entering author. For example searching for author John Smith should read: author:“J Smith” or author:“John Smith”.

Enter your text, remember quotation marks when needed
b. To search for a specific word in the title of the article, type: intitle:cancer, if looking for an article with the word “cancer” in the title.

2. Advanced Scholar Search

a. Advanced Scholar Search is a tool that should be used when searching for articles printed from a specific date, or a specific author or publication. It is a quick way to retrieve articles tailored to exactly what you are looking for.

3. Using the Scholar toolbar

a. The Toolbar that appears on the page displaying your search results allows you to easily refine your search results. Select if you want to see articles and patents or legal opinions and documents or select how recent you want the article to be. Choose if you want to see citations or only summaries displayed in your search results.

Retrieving Results

Information Technology Services, UIS
1. Your results page will look similar to the results from making a common Google search.

   ![Google Scholar Search](image)

   **Blue text:** title of the publication  
   **Green text:** author names, journal, dates, and databases  
   **Black text:** selection of the abstract of the article

   **Cancer statistics, 2004**  
   A.Jemal, RC Tiwari, T Murray, A. Ghafoor, A. - CA, a cancer journal ... breast, and colon and rectum in women continue to be the most common cancer sites. The increased use of hormone replacement therapy, an increased prevalence of obesity, or both ... 2001. A total of 563,768 cancer deaths were recorded in the United States in 2001. Cited by 2164 - Related articles - UM Direct - All versions

   **Association between obesity and psychiatric disorders in the U.S.**  
   Community surveys used to examine associations between psychiatric disorders and obesity. Community surveys used to examine associations between psychiatric disorders and obesity.

2. Some articles will allow you to view the full PDF at no charge by simply clicking the title, where others charge a fee to view the complete article. When using Google Scholar on the UIS server, a link will appear that will allow you to receive the full text for free through the UIS database.

   ![Google Scholar Link](image)

   **Blue text:** title of the publication  
   **Green text:** author names, journal, dates, and databases  
   **Black text:** selection of the abstract of the article

   **Cancer statistics, 2004**  
   A. Jemal, RC Tiwari, T. Murray, A. Ghafoor, A. - CA, a cancer journal ... breast, and colon and rectum in women continue to be the most common cancer sites. The increased use of hormone replacement therapy, an increased prevalence of obesity, or both ... 2001. A total of 563,768 cancer deaths were recorded in the United States in 2001. Cited by 2164 - Related articles - UM Direct - All versions

   **Get a free full text?** Hospital-camuses.com [loc]/b0c

   a. Click the link, and you will be directed to the Brookens Library search page. The information to receive the article you selected will be entered for you, simply select Go.

   ![Brookens Library](image)

   b. You will be directed to the database where the article is originally from, and will be able to select Get PDF to retrieve the article at no charge.
3. Another useful way to retrieve more related articles from a search is the Cited by link. This link appears under all articles retrieved from a search, and will link you to more articles that have cited the original article.

4. The Related articles link will display articles that are directly related to the specific article you are viewing.

Google Maps

Google Maps is an application that offers an abundance of tools. To access Google Maps, type [www.maps.google.com](http://www.maps.google.com) into your browser, or select Maps on the Google homepage.

Using the Map

1. Navigating
   a. Zooming in and out on Google Maps can be done in a variety of ways. Most simply, using the wheel on the mouse and pushing forward will zoom in, and backward will zoom out.
   b. The navigation bar located to the left of every map can also be used to zoom in and out by clicking the “+” and “-” buttons, or dragging the bar on the scale.
   c. By right clicking on any part of a map, Zoom in and Zoom out are options to select.
d. To view the geographical features of a map select **Satellite** at the top right of the map. To view only streets and highways, select **Map**.

2. Finding a location
   a. The simplest way to find a location on Google Maps is to simply type the city or address you are searching for, and then click **Search Maps**.

   ![Google Maps Screenshot](image)

   b. You can set a default location by clicking **Set default location** to the left of the map, then entering the location and saving it. This will make it your set location when you enter Google Maps.

3. Getting Street Views
   a. One of the most popular features of Google Maps is the ability to get street views of certain locations when they are available. Simply click the **person figure** to the left of the map, and **drag and drop** it wherever you want to see a street view. The streets will be highlighted in blue where street views are available.

   i. **Click and drag** around with your mouse to view different angles of the street view. Also, for more popular locations, icons will appear at
the top prompting other popular locations nearby. Click on the thumbnail to see other street views.

4. Traffic
   a. Another great advantage of Google Maps is that it tracks traffic live and makes it available for you to view whenever needed. Click the Traffic button to the top right of the map. Points of construction and area restrictions will also be identified.

5. What’s here?

Click the icon of interest for more information regarding construction zone or area restriction
a. Users are able to right click on any point and select **What’s here?** from the dropdown menu to view local points of interest. On the left of the screen, photos and places will appear with links to view for more information.

![Google Maps interface showing Chicago, IL location and search options](image)

**Getting Directions**

1. Click the **Get Directions** tab to the left of the screen to enter a destination and starting point for directions. You are able to enter specific addresses, or cities for a more general route of how to reach a destination. After entering your destinations, select **Get Directions**.

![Google Maps interface with Get Directions button highlighted](image)

2. Google Maps will give you directions for four different modes of transportation.
   a. **Driving directions**
b. Public transportation

Select options to decide which route is best for you

Choose between the routes they have calculated

Select when you wish to depart

c. Walking directions

Walking directions are not guaranteed

d. Bicycling
Extras

1. Traveling the world from home is made possible with Google Maps. Simply type in any location in the search bar along the top of the screen, and you will be able to access a variety of different tools to explore your specified area.
   a. Select the More tab along the top right of the map.

Bicycling directions are not guaranteed

Photos, videos, or links to Wikipedia will appear at specific locations and landmarks

Check the box of the type of information you want displayed

Select to view the location of real estate available in the area

View what’s going on nearby at specific locations through posts by other users with Buzz